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1. PURPOSE. This pamphlet provides instructions on how to
establish a Fort Sill domain account and using the features
included with the account.

2. SCOPE. This pamphlet pertains to all organizations using the
Fort Sill domain.

3. GETTING AN ACCOUNT. Contact your Information Systems
Security Officer (ISSO). This individual can submit an FS Form
180 to request new accounts or make changes to an existing
account. Directorate of Plans, Training, and Mobilization,
Security Division maintains a listing of all ISSOs.

4. LOGGING ONTO THE FORT SILL DOMAIN.

a. Once you have received your userid and password, you are
ready to log onto the Fort Sill domain.

b. When you turn-on your computer a screen appears
requesting your userid, password, and domain name. Insert your
userid, password, domain name (fortsill), and press "enter." If
you receive the screen shown in figure 1, you have successfully
logged onto the Fort Sill Domain. Press "yes" to continue.

Figure 1. Warning: This is a DOD Computer System Screen
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5. DOMAIN SERVICES. Using the "start" button at the bottom left
of your screen, you can access the domain services (see figure
2).

Figure 2. Start Button Screen

a. Local Applications. By pressing the "start" button and
clicking on "Fort Sill Menu," you can access local applications
(see figure 3). These local applications are--
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Figure 3. Fort Sill Menu Screen (Local Applications)

(1) The Automated Temporary Duty System. This system allows
users to submit and route travel orders. For assistance contact,
call 442-5914.

(2) The Contracts Database System. This is systems managers
AFP Reports and Document Registers. For assistance contact, call
442-5914.

(3) Input Telephone Work Orders. This system loads a
telephone work request and provides instructions on how to route
electronically.

(4) Training Command Document Register. This system is for
use by Training Command Budget Analysts.

b. Miscellaneous Applications Utilities. By pressing the
"start" button and clicking on "Fort Sill Menu," you can access
miscellaneous applications utilities (see figure 4). These
applications are--
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Figure 4. Fort Sill Menu Screen (Miscellaneous Applications
Utilities)

(1) Civil Service Retirement. This is a program that
calculates civil service retirement date and salary.

(2) Credit Card Software. This program is used by Fort Sill
IMPAC card holders. Program will run only if installed in
C:\ccard folder on your computer. For assistance contact, call
442-5914.

(3) DA Pam 25-30. This is the current electronic version of
DA Pam 25-30.

(4) EPSQ (Win Ver). This program is Security Clearance
Update. It will install to your computer. For assistance
contact, call 442-2914.
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(5) FEDLOG. This is the current online FEDeral LOGistics.

(6) FormFlow Filler. This program loads the FormFlow
program. Use #7 from this menu for proper installation.
Electronic forms are available on the Fort Sill Intranet
(http://www1.doim.sill.army.mil). Fort Sill electronic forms are
available on the IASB Home Page (http://sill-www.army.mil).

(7) Install FormFlow Filler. This silent install will setup
FormFlow on your computer so you can use #6 on this menu.

c. Networks. By pressing the "start" button and clicking on
"Fort Sill Menu," you can access network applications (see figure
5). These applications are--

Figure 5. Fort Sill Menu Screen (Networks)

(1) ASIMS. Allows access to ASIMS authorized users. ASIMS
systems include STARFIARS-MOD, SEES, STANFINS, and SRDI. For
assistance, contact 442-5527/5823.
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(2) ATRRS. Allows access to ATRRS authorized users.
Organization ISSOs must submit requests for access to this
program. For assistance, contact 442-2182.

(3) Civilian Personnel PPI. This program provides access to
the Civilian Personnel System for valid users. For assistance,
contact 442-5259.

(4) DA Installation Support Modules (DAISMS). This program
allows access to DAISMS. DAISMS include CIF, Post Locator,
EDMIS, In- and outprocessing, TRANSORD, TRANSPROC II, AIMS-PC,
and DENTRAD. Users must have a valid account to access these
systems. You must send your request for access to the DOIM ISSO.
For assistance contact, 442-2182. NOTE: AIMS-PC is a DAISM but
local access is controlled by the AIMS-PC functional manager.
For assistance, contact 442-3611.

(5) File Transfer Protocol. This tool allows file
transfers. For more file sharing options see Filing Sharing.

(6) PERNET. This system allows connection for authorized
users of PERNET.

6. THE FORT SILL INTRANET. To access this site, open your web
browser (i.e., Internet Explorer, Netscape) and in the address
box type-- http://www1.doim.sill.army.mil.

a. The Intranet contains information that is relevant to the
internal affairs at Fort Sill. It cannot contain Privacy Act
Information. This information is viewable only to the Fort Sill
network community and is blocked to the general public. This
page should be set as your browser's home page or you should view
it regularly for up-to-date virus information, policies,
departmental information, and other official notices. The
opening page offers a menu on the left and hot links at the
bottom of the screen (see figure 6). Click on any menu to
navigate the site.
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Figure 6. Fort Sill Intranet

b. For information about the Fort Sill Intranet, send e-mail
to the Fort Sill Webmaster (donnellb@sill.army.mil).

7. FORT SILL HOME PAGE. To access this site open your web
browser, (i.e., Internet Explorer, Netscape) in the address box
type-- http://sill-www.army.mil.

a. The Fort Sill home page contains information about Fort
Sill and is viewable to the Internet community worldwide. It
cannot contain Privacy Act Information. There is a menu on the
left and hot links at the bottom of the screen to assist you in
navigating this Fort Sill site (see figure 7).
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Figure 7. Fort Sill Home Page

b. For information about the Fort Sill Home Page, send e-
mail to the Fort Sill Webmaster (donnellb@sill.army.mil).

8. NETWORK PRINTERS/COPIERS. There are network printers and
copiers located throughout the installation. If you would like
to add a network printer or copier in your area, contact 442-
1942. To add a network printer or copier to your computer, click
on the start button, settings, control panel, add printer, click
on "Network Printer Server, and press "Next." System will
automatically access Network Neighborhood (see figure 8). You
need to browse to "PS-FDDI" and select the appropriate printer or
copier (see figure 9). Follow instructions on your screen to
complete the addition of the printer or copier to your computer.
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Figure 8. Network Printers/Copiers
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Figure 9. Network Printers/Copiers (Finding Printer/Copier)

9. FILE SHARING. There are several ways to share files. E-mail
is not always the way to get files to other users. There is a
limit on e-mail size (5MB), which includes attachments. Sending
large files puts an unnecessary burden on the e-mail system.
There are three other ways to provide these files to others.
These drives cannot contain Privacy Act Information.

a. Network Drives (preferred method). Several network
drives are available to you when you successfully log onto the
Fort Sill Domain. They are--

(1) S Drive. This drive is setup for sharing files within
your department only. You are a member of your department's
group and only members of your group can access this drive.
Others do not have access to it. You are responsible for keeping
this drive clean. When data is no longer needed, please delete
it.
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(2) P Drive. This is a public drive for temporary storage.
Files have a 2 week life cycle and are then deleted from the
drive. This is the preferred method of sharing files with other
Fort Sill NT domain users rather than over-burdening the E-mail
system with large file attachments.

(3) J Drive. This drive contains various Fort Sill
applications. You cannot write to this drive. You can only copy
files from this drive such as forms, graphics, etc.

b. Large File Transfers Using ASP. You can use the ASP File
Upload Site to share large files with users on Fort Sill and
outside world (see figure 10). To access--

Figure 10. Large File Transfers Using ASP

(1) Open Internet Explorer or Netscape and go to--
http://sill-www.army.mil/safe/form/asp.

(2) Instructions are on the screen and easy to follow.



USAFACFS Pam 25-70, 27 November 2000

13

(3) Files that are uploaded are stored at FTP://sill-
www.army.mil.

(4) Use your web browser to reach this site to download
stored files.

c. File Transfer Protocol (FTP). To access-- (see figure
11)

Figure 11. File Transfer Protocol (FTP)

(1) Click on lower left corner on the Start button to find
the Fort Sill Menu.

(2) Select Networks.

(3) Select File Transfer Protocol.
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(4) Enter the Profile name - this is the name you will refer
to the next time you start this program (i.e., sill).

(5) Enter the FTP address less the FTP://, i.e. sill-
www.army.mil).

(6) Click on the anonymous button if a unique userid is not
required at the FTP site.

(7) If an unique userid is required, enter it.

(8) If an unique password is required, enter it.

(9) Click the apply button to save these settings for the
next time you wish to access this site.

(10) To connect to the site click the OK button.

(11) The FTP directory and files will appear in the right
window.

(12) The local directory appears in the left window.

(13) To upload a file, change directories in the left window
until you find the files you wish to upload. Click on the
greater than button to upload the file.

(14) To download a file, change directories in the left
window to where you want the file to finally reside. Select the
file to download in the right window and then click the less than
arrow to begin the download.

d. ISS Risks. To mitigate the ISS risks associated with FTP
services, Fort Sill has implemented the following procedures.

(1) Use of network shares/files permissions (i.e., shared
folders/directories).

(2) E-Mail attachments (less than 5MB).

(3) Use File Transfer Protocol (FTP).

(4) The Fort Sill Internet FTP site - ftp://sill-
www.army.mil. You will use the site only to--

(a) Transfer those files in access of 5MB.

(b) Transfer files to recipients off-post or not connected
to the Fort Sill domain.
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(c) Receive files from senders off-post or not connected to
the Fort Sill domain.

(5) Zip and password protect all files uploaded to all
publicly accessible Internet FTP sites with either WINZIP or
PKZIP. You can download a copy of the site-licensed version from
the Fort Sill Intranet at-
http://www1.doim.sill.army.mil/soft/win2k.htm.

(6) DOIM will monitor the FTP site and will remove those
files that are not zipped or have remained on the site for more
than 24 hours.

(7) Files that require transmission within Fort Sill but are
excess of the 5MB E-mail limit will--

(a) Use network shares/files permission (i.e., shared
folders/directories).

(b) Use of the Fort Sill Intranet FTP site
(FTP://www1.doim.sill.army.mil). Files transferred to this site
are not accessible from off-post and therefore you are not
required zip them.

(8) You can find the procedures to use the commercial
program WINZIP on the Fort Sill Intranet at-
http://www1.doim.sill.army.mil/help/winzip.ppt.

(9) For assistance call, 442-5739 or E-mail
(donnellb@sill.army.mil).

10. GETTING HELP.

a. Help Desk. To call the help desk, dial 103. Do not use
the prefix 2-.

b. You will get a guided message that allows you to get--

(1) Telephone outage assistance.

(2) Interactive help (if you are able to log onto the Fort
Sill domain). Please know your PC name. If you do not know,
right click on Network Neighborhood on your desktop, go to
properties, and identification tab.

(3) Copier repair assistance (CPC Contract Copiers only
(Minoltas)). For all others, except tactical, call 442-3816.

(4) Hardware repair status.
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(5) Status on Fort Sill network outages and maintenance
schedules.

(6) An operator who will submit a trouble ticket for you.

c. Submitting a Trouble Ticket (see figure 12).

Figure 12. Open a New Call (Trouble Ticket)

(1) Open your browser, either Internet Explorer or Netscape.

(2) Go to the Fort Sill Intranet-
http://www1.doim.sill.army.mil.

(3) From the menu, select help.

(4) Open DOIM Help Desk.

(5) Double click on Open a New Trouble Call.
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(6) Type in Client ID. Use one of the following that is
applicable to your organization.

(a) Garrison.

(b) TngCmd

(c) Tenant.

(d) Other.

(7) Select a subject.

(8) Type in description of problem. Include the following
in the Description Box. POC and phone number, e-mail address,
office, building and room number, and description of your
problem.

(9) Click on Open a New Call.

(10) Write down your Call Number of future reference.

d. Hardware Repair.

(1) Submit a trouble ticket as described above.

(2) Select Hardware as subject.

(3) In the Description Box, be sure to include the equipment
make, model and serial number, POC, e-mail address and Office and
phone number or call 103 and ask an operator to submit a trouble
ticket for you.

(4) Take your equipment to the basement of Bldg 462, room
11.

(5) Direct questions concerning hardware upgrades or repairs
to 442-4093.

NOTE: If the equipment had not arrived after 10 working days,
DOIM will close the work order.

11. FORT SILL ELECTRONIC MAIL (E-MAIL).

a. Open Outlook.

(1) Type your USER NAME (this is your Domain User ID,
typically lastname, first initial).
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(2) Type the DOMAIN NAME (fortsill) if not retained in name
block.

(3) Type your PASSWORD (this password is case sensitive).

(4) See figure 13.

Figure 13. Opening MS Outlook

b. Your Mailbox.

(1) Creating a Message.

(a) On the File menu, point to New, click Mail Message or
point to Actions, then New Mail Message.

(b) In the To, Cc or Bcc boxes, enter recipient names
separating each with a semicolon.

(c) On the File menu, point to Check Name, or use the short
cut ALT + K or click Address Book on the Tools menu; select a
name from the Global Address List, Personal Address Book, or
others; or to address a recipient outside the Fort Sill Domain,
type the full email address of the recipient.

Example:
userid@tradoc.army.mil

(d) In the Subject box, type the Subject of the message.
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(e) In the text box, type the message. If your text or

attachment contains Privacy Act information, type "FOR
OFFICIAL USE ONLY" in big, bold letters directly under the
subject box as your first line of text.

(f) Click Send.

c. Open a Message.

(1) Click Inbox.

(2) In the message list, double-click the message you want.

d. Reply to a Message.

(1) Open the message you want to reply to.

(2) To reply to only the sender of the message, click Reply.
This does not return attachments to sender.

(3) To reply to all of the recipients in the To and Cc
boxes, click Reply to All. By default, this does not return
attachments to the recipients.

e. Forward a Message.

(1) Click Inbox.

(2) Select the message you want to forward.

(3) Click Forward. By default, this also forwards
attachments.

(4) Enter recipient names in the To, Cc, or Bcc boxes (To
select recipient names from a list, click the To, Cc, or Bcc
button.)

(5) Click Send.

f. Delete Messages.

(1) Click Inbox.

(2) Select the messages you want to delete.

(3) Click Delete.

g. Email bandwidth reduction procedures.
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(1) Use graphics sparingly in e-mail attachments. Avoid
rich context pictures requiring large amounts of memory. Where
possible, use text and graphics in black and white. Omit logos
and seals on all but the title slide of a briefing.

(2) Use government provided e-mail services vice commercial
web-based e-mail services, except where Government provided
services are not available. Bandwidth overhead associated with
the use of web-based e-mail is excessive and can constrict
communication paths.

(3) Reduce lengthy e-mail document attachments and
addressees, including the number of courtesy copies. Place
documents on web servers whenever possible. Provide a Uniform
Resource Locator (URL) indicating where recipients can easily
access documents via the Internet.

(4) Download large files from Web sites only when absolutely
necessary and for official business. However, downloading from a
Web site is preferable to sending lengthy files by e-mail to
large lists of addressees. Install documents of high interest on
the organization’s Intranet or on the Internet.

(5) Compress large e-mail attachments to conserve bandwidth.

(6) Limit official subscriptions to newsgroups to those that
support the organization’s missions and functions. Reduce or
eliminate individual personal subscriptions to newsgroups.
Eliminate personal web services such as Pointcast.

(7) When using the “Reply” and “Reply to All” e-mail
feature, avoid quoted replies/in-line replies (i.e., complete e-
mail strings) to the maximum extent possible.

(8) Do not use the “Return Receipt” e-mail feature as a
matter of routine. Use only on official e-mail when you must
positively verify receipt (e.g., where the e-mail has a direct
bearing on the mission).

(9) Use Intranets or shared network drives (P: and S:) for
sharing widely used documents.

h. Personal Address Book.

(a) Saving an Address of an Incoming Message to your
Personal Address Book.

1 Open message.

2 In the from area, right click the from address.
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3 Click Add to Personal Address Book.

(b) Create a personal distribution list.

1 On the Tools menu, click Address Book.

2 Click New Entry.

3 In the Select the entry type box, click Personal
Distribution List, and then click OK.

4 In the Name box, type a name for the List.

5 Click Add/Remove members.

6 In the Show names from the box, select the address book
that contains the names you want to add to your personal
distribution list.

7 In the Type name or select from list box, type each name
you want to add. In the list below, double-click each name.

i. Personal Folders. You cannot use personal folders within
E-mail to retain documents IAW AR 25-400-2.

(1) Creating New Personal Folders.

(a) From the folder list, right click on Personal Folders.

(b) Select New, Folder.

(c) Give it a name.

(2) Saving Messages to Personal Folders. From any folder in
the Mailbox, click and drag messages to the desire personal
folder.

j. Backing Up Personal Folders. A Personal folder file has
a .pst extension and is located on your PC’s hard disk, not on
the server. You work with a personal folder file as you would
with any other file, and you can save, copy, and move a .pst file
to another location on your hard disk, a 3.5" disk, or a server.
To find your personal folder file do the following.

(a) On the Menu Bar, go to tools.

(b) Select Services.

(c) Double click on Personal Folders.
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(d) Look at Path, this tells you were your folders are
(i.e., c:\exchange\userid.pst).

k. Managing Your Exchange Mailbox. Your mailbox has a size
limit. When you exceed that limit, you get a note from the
System Administrator telling you so. You will not be able to
send mail until it is cleaned up. Users with excessive amounts
of mail will not be able to send or receive until cleanup is
accomplished. To do so: delete or move messages to Personal
Folders from the Mailbox (this includes ALL folders in the
Mailbox).

l. Public Folders.

a. Public folders are a way to share information with others
who have access to Fort Sill Email. Public folders are created
and designed by the Administrator and designated persons in your
organization who have been given the appropriate permission to
control the folder. These designated persons are the only ones
who can post to, and delete items in the folder.

b. Due to the increased overhead public folders place on the
Fort Sill mail servers, this method is the least favored and will
be used only as a last resort. To share information, use one of
the three methods mentioned in the file sharing section of this
pamphlet. To share information to the largest audience possible,
consider using the Fort Sill Intranet or Internet.

c. For information on public folders, contact the Fort Sill
E-mail Administrator, 442-6289.

12. REMOTE ACCESS.

a. Terminal Server Access Controller System (TSACS). TSACS
allows remote access to the Fort Sill Network (see figure 14).
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Figure 14. Remote Access to E-Mail

(1) You must have a current TSACS account. Your ISSO can
request one for you. For assistance, contact 442-2182 or 442-
3013.

(2) Your computer must have a modem and Dial-up Networking
setup. Complete instructions can be found on the Fort Sill
Intranet -

http://www1.doim.sill.army.mil.

(3) To connect to the TSACS server locally, dial 442-6998.

NOTE: DA and TRADOC has mandated all TSACS users must use the
local number first for access. If you are traveling to another
installation, check the Intranet link

http://www1.doim.sill.army.mil/TSACS/index.htm

to find that installation's local TSACS number. Lastly, if you
are in an area that does not have access to a local TSACS number,
only then are you allowed to use the toll free number (1-877-210-
9547).
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(4) TSACS validates your user ID and password. You now have
access to the Fort Sill Network.

13. WEB ACCESS. Web Access allows you to check your e-mail from
your home or TDY site.

a. You must have Internet access.

b. Enable your browser with 128 bit cipher strength
encryption.

c. Using your browser, in the address box, type:

http://webmail.sill.army.mil.

d. Click on the box "click here."

e. Logon screen prompts you for USERID. Use your Fort Sill
Domain user ID.

f. The next screen prompts for your userid and password.
Again, use your Fort Sill Domain user ID and password.

g. You now have access to your mailbox. Note: You are not
using Outlook as on your computer at work, so all options are not
available to you.

14. DEFENSE MESSAGE SYSTEM (DMS).

a. The Defense Message System (DMS) for Organizational
Messaging is now operational at Fort Sill. DOIM is currently
posturing itself to provide continued messaging support for
organizations using AUTODIN, by transitioning them to DMS. HQDA
has mandated this requirement, and the scheduled transition from
the Automatic Digital Network (AUTODIN) messaging system to the
DMS system is currently underway.

b. DOIM is currently adding users and issuing Fortezza cards
for this system. In order to minimize disruption of messaging
service, organizational accounts must be enabled, operational,
and messaging rerouted before the scheduled AUTODIN shutdown.
This section is to advise you of what must be done.

c. DOIM has established a DMS Resource Page on the Fort Sill
Intranet server (http://www1.doim.sill.army.mil/dms) regarding
Fort Sill DMS implementation and general guidelines/procedures on
establishing accounts.

d. DMS Organizational Messaging is a new technology
replacement for the over-the-counter AUTODIN Messaging System and
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DINAH/SARAH message services provided by the DOIM’s
Telecommunications Center (TCC) in Bldg 1645. DMS provides
messaging on two separate platforms: Sensitive-But-Unclassified
(SBU) messaging, and Classified (SECRET) messaging. Classified
(Secret) messaging requires special connectivity to the SIPR
network. Only a few organizations will have this access.
Organizations not having this connectivity are required to visit
DOIM TCC to access the Classified (Secret) network and access
their DMS mailbox. If a user needs both messaging services,
(Unclassified and Classified), the organization must request an
Organization Account and Fortezza card for each service.

e. From a user’s workstation, DMS provides messaging
capability using an augmented commercial electronic mail client
and a physical security token. The DoD Information Services
Agency (DISA) and the Army designed, funded, acquired, and
installed the infrastructure to satisfy the Fort Sill
organizational messaging requirement. DOIM will initially
support approximately 32 of the core organizational users across
the installation for Unclassified (SBU) messaging. DOIM will
also be supplying Classified (Secret) messaging support for a
smaller number of organizational users.

f. There will be two separate DMS e-mail platforms replacing
the current AUTODIN system. One server will provide Unclassified
(SBU) service and another will provide Classified (Secret)
messaging service. Your organization must register for the
appropriate service. If your organization needs support for both
Unclassified (SBU) and Classified (Secret), your organization’s
ISSO must submit a Fort Sill Form 598 (X.509 Certificate Request
Form) for each service. This form is located at http://sill-
www.army.mil/doim/.

g. DOIM TCC will no longer function as a walk-in, over-the-
counter message center after AUTODIN shutdown. Organizations
that have depended on this type service in the past must now have
an established mailbox on the appropriate DMS platform in order
to continue messaging service. Make sure your organization has a
DMS mailbox for the support you are currently receiving on
AUTODIN prior to shutdown. If not, your messaging service could
be disrupted.

h. If your organization does not have the necessary network
connectivity for Classified (Secret) messaging, DOIM TCC in Bldg
1645 and the DOIM server facility in Bldg 462 will provide secure
work areas with a PC and DMS client software loaded in order to
provide access to the appropriate DMS Server/mailbox and
messaging capability.
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i. DOIM intends to conduct DMS training/orientation for
organizational users prior to official shutdown of AUTODIN at
Fort Sill.

j. Fort Sill Pam 25-10 and Reference Guides will be
available for handout during these training sessions.

k. For assistance in DMS contact 442-6513 or e-mail
cunningj@sill.army.mil.

15. TRAINING.

a. New User Training. DOIM will provide training to all new
users prior to issuance of Domain User ID and password. This
will familiarize the user with the local services available and
give an overview of Fort Sill automation policy. DOIM will
notify new users of the next scheduled class.

b. DMS Training. DOIM will provide training to all new DMS
users prior to issuance of Fortezza card and pin letter. DOIM
will also train ISSOs on how to complete Fort Sill Form 598
(X.509 Certificate Request Form) for DMS accounts. DOIM will
notify new users and ISSOs of the next scheduled class.

(ATZR-UO)

FOR THE COMMANDER:

P
D
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F
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DAVID C. RALSTON
Colonel, FA
Chief of Staff

HYLLIS R. BACON
irector of Information
Management

ISTRIBITION:
ort Sill Internet
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	(1)  Creating a Message.
	
	c.  Open a Message.
	d.  Reply to a Message.

	e.  Forward a Message.
	f.  Delete Messages.
	g.  Email bandwidth reduction procedures.

	h.  Personal Address Book.

	(b)  Create a personal distribution list.
	
	
	i.  Personal Folders.  You cannot use personal folders within E-mail to retain documents IAW AR 25-400-2.
	(1)  Creating New Personal Folders.

	(2)  Saving Messages to Personal Folders.  From any folder in the Mailbox, click and drag messages to the desire personal folder.




